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** Help groups start here



Color topics
Click on any of the following topics to know more about that subject:

Automatic
Calibrate Screen
Color as grayscale 
ColorSmart
Convert colors to pure Black
Halftoning
Match Screen 
Manual Color Control
No Adjustment 
Normal 
PANTONE®* Colors
Printed Color Control
Vivid Color 

To return to the Help Groups Index click on Contents.



Media topics
Click on any of the following topics to know more about that subject:

Custom paper size
Custom paper size limits 
How to calculate a printable area 
Loading sheet paper
More sizes 
Orientation 
Oversize 
Paper Size List
Paper Source 
Paper Type List 
Printable areas 
Used standards
User-defined Size 

To return to the Help Groups Index click on Contents.



Setup topics
Click on any of the following topics to know more about that subject:

Copies
Defaults - Color Control dialog box 
Defaults - Options dialog box 
In printer/computer 
Long-axis prints
Orientation 
Paper Sizes dialog box 
Paper Type 
Print Quality
Setup dialog box 
Supported Printers
User configurations

To return to the Help Groups Index click on Contents.



Miscellaneous topics
Click on any of the following topics to know more about that subject:

What is ANSI? 
What is Architectural? 
What is DIN? 
What is ISO? 
What is JIS? 

To return to the Help Groups Index click on Contents.



Troubleshooting topics
Click on any of the following topics to know more about that subject:

General Information 
General Troubleshooting

Canceling a print from your application 
Customer Support
Memory Problems
Readme.txt 
Software Application notes
Troubleshooting printer problems

To return to the Help Groups Index click on Contents.



** Dialog box descriptions start here.



Setup dialog box help 
The contents of the Options dialog box match the capabilities of the currently selected 
printer, for help specific to the Options dialog box for your printer, click the Options button
in the Setup dialog box, then click the Help button.

To access the Print setup dialog box in Windows 3.1:- 
from the Program Manager window open the Main window and double click 
Control Panel, double click Printers, and with your output device selected, then 
click the Setup... button.

To access the Print Setup dialog box in Windows 95:-
from the desktop click on Start, and select Settings and then click on Printers.    In 
the Printers dialog box click on your HP DesignJet printer icon with the right mouse
button, and select Properties from the pop-up menu.    Click on the Details tab and
click on the Setup button.    

Choose one of the highlighted text fields for more information:

Notes: 1) Please note that the settings in this Setup dialog box may have a global effect.    Depending on the 
behavior of your application, the settings may be valid for all your applications.

2) The appearance of the print setup dialog box may vary from the example shown above, however the 
behavior of the settings you enter is the same.

Associated topics:
Custom paper size
More sizes...
Options - HP DesignJet 250C, 650C (B-series), 750C & 755CM
Options - HP DesignJet 200, 220, 230, 600, & 650C (A-series)
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Color Control dialog box help
Click on any of the following topics for information on color options.

Help Topics

Calibrate Screen
Cluster
Defaults
Halftoning
Lightness
Match Screen
No Adjustment
PANTONE®* Colors
Pattern 
Printed Color Control
Scatter 
Vivid Color

PANTONE Color simulations are only available with this driver when driven by qualified Pantone-licensed 
software packages.    Contact Pantone, Inc. for a current list of qualified licensees.

* Pantone, Inc.'s check-standard trademark for color. Pantone, Inc., 1988

ATM users should note that the color of text sent to the printer as graphics will be enhanced 
using the settings in the Graphics column.    The recommended setting in the ATM Control 
Panel is "Use pre-built or resident fonts" this will avoid differences in text color and improve 
performance.

Text which is rotated is sometimes sent to the printer as graphics and will be enhanced 
according to the Graphics setting.

For More Information

For information on printer setup, click Help... in the Setup dialog box.

For late-breaking information on using your printer in a Windows environment, check the 
README.TXT file.

For information on your printer, refer to the printer's user documentation.

To print this or any other help topic, choose Print Topic from the File menu in the Help 
window.
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Color Control dialog box help
Click on any of the following topics for information on color options.

Help Topics

Calibrate Screen
Cluster
Defaults
Halftoning
Lightness
Match Screen
No Adjustment
Pattern 
Printed Color Control
Scatter 
Vivid Color

ATM users should note that the color of text sent to the printer as graphics will be enhanced 
using the settings in the Graphics column.    The recommended setting in the ATM Control 
Panel is "Use pre-built or resident fonts" this will avoid differences in text color and improve 
performance.

Text which is rotated is sometimes sent to the printer as graphics and will be enhanced 
according to the Graphics setting.

For More Information

For information on printer setup, click Help... in the Setup dialog box.

For late-breaking information on using your printer in a Windows environment, check the 
README.TXT file.

For information on your printer, refer to the printer's user documentation.

To print this or any other help topic, choose Print Topic from the File menu in the Help 
window.
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Color Control dialog box help
Click on any of the following topics for information on color options.

Help Topics

Convert colors to pure Black
Defaults
Halftoning
Lightness 
Pattern 
Scatter 
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Color Control dialog box help
Click on any of the following topics for information on color options.

Help Topics

Defaults
Halftoning
Lightness 
Pattern
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Options dialog box help
Click on any of the following topics for information on setting up the HP Printer Driver 
(HP-GL/2 and HP RTL) for Microsoft Windows 3.1.    Use the scroll bar to see text not 
currently visible in the Help window.

Help Topics:
Automatic
Color as Grayscale
Configuration name
Copies
Defaults
In printer/In computer
Manual Color
Paper Type
Print Quality 

Click on any one of the above to see an explanation of the effect that the setting will have 
on your printed drawing.

Associated topics:
Color Control - Manual color selected
Color Control - Color as Grayscale selected
Paper size

Help Screen Text    Copyright    1995 by Hewlett-Packard Company. Fifth Edition, June 1995.



Options dialog box help
Click on any of the following topics for information on setting up the HP Printer Driver 
(HP-GL/2 and HP RTL) for Microsoft Windows 3.1.    Use the scroll bar to see text not 
currently visible in the Help window.

Help Topics:
Automatic
Color as Grayscale
Copies
Defaults 
In printer/In computer
Manual Color
Paper Type
Print Quality 

Click on any one of the above to see an explanation of the effect that the setting will have 
on your printed drawing.

Associated topics:
Color Control - Manual Color selected
Color Control - Color as Grayscale selected
Paper size
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Options dialog box help
Click on any of the following topics for information on setting up the HP Printer Driver 
(HP-GL/2 and HP RTL) for Microsoft Windows 3.1.    Use the scroll bar to see text not 
currently visible in the Help window.

Help Topics:
Convert colors to pure 
Black
Color as Grayscale
Configuration name
Copies
Defaults
In printer/In computer
Normal
Print Quality 

Click on any one of the above to see an explanation of the effect that the setting will have 
on your printed drawing.

Associated topics:
Color Control
Lightness
Paper size
Pattern 
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Options dialog box help
Click on any of the following topics for information on setting up the HP Printer Driver 
(HP-GL/2 and HP RTL) for Microsoft Windows 3.1.    Use the scroll bar to see text not 
currently visible in the Help window.

Help Topics:
Convert colors to Black
Color as Grayscale
Color Control
Copies
Defaults
In printer/In computer
Normal
Print Quality 

Click on any one of the above to see an explanation of the effect that the setting will have 
on your printed drawing.

Associated topics:
Lightness
Paper size
Pattern
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User configurations dialog box

        

The User configurations dialog box allows you to save, re-load and delete pre-set driver 
configurations.    All your currently chosen settings for Color, Paper Type, Print Quality, Copies
etc. can be saved using a 'configuration' name, and loaded later for re-use whenever you 
want to repeat the same type of print job.



Paper Sizes Dialog box
Click on any of the following topics to find out more about the parameter settings in this 
dialog box.

Custom paper size 
Oversize 
Units
Used standards - Paper sizes 

Help Screen Text Copyright    1995 by Hewlett-Packard Company. Fifth Edition, June 1995.



** Topics start here



Automatic

                                                      IMPORTANT !!

HP DesignJet 250C, 650C (C2858B and C2859B only), 750C and 755CM

NOTE:Because of the diversity of printing requirements and color options, Hewlett-Packard 
has provided Automatic, an option which utilizes ColorSmart technology to pre-set 
all the printed color control options.    Automatic is a one-button solution to high-
quality color output.

Automatic provides an easy solution to consistent and intelligent color management in your
printed output.    It analyzes your output for you, identifies the component objects as text, 
graphics and images, and then automatically maximizes the vibrancy, clarity and color-
matching capabilities of your printer.    High-quality color output, all at the touch of a button.

Manual Color is an alternative to Automatic, select Manual Color and then Color 
Control... to open the Color Control dialog box.    The features in the Color Control dialog 
box allow you to control the colors of your printed output according to your particular needs.



Calibrate Screen
Screen calibration provides the characteristics of your monitor, and the lighting around it, to 
the printer driver.    The printer driver uses this information to better match the printer 
output to what you see on your screen.    Screen calibration has an effect only when Printed
Color Control in the Color Control dialog box is set to Match Screen.

Click the Calibrate Screen... button to open the dialog box which offers you the choice of 
three methods of screen calibration.    All three types of calibration directly affect the Match 
Screen options under the Printed Color Control section.

Click the Help button in the Hewlett-Packard Screen Calibration dialog box to display 
the help topics on the different methods of screen calibration.    



Canceling a print from your application
Take care when you cancel a print which has been sent to the printer.    You may not always 
get the desired result, i.e. the printer may have already received part of your drawing at the 
time you chose to cancel, and the next time you send a print the printer will begin to draw 
the print you canceled.    To help you cancel a print satisfactorily we have provided a 
recommended method, this is as follows:

a) Find the window which shows you that your document is being sent to the printer, as 
illustrated below.    (If you cannot see this window try an ALT-TAB sequence to display other 
active windows)

b) Click the Cancel button.
c) Wait for some time to allow your application to stop sending data.
d) You should be returned to your application.

In the event that you are not returned to your application click the Cancel button in your 
application but you may experience problems.    This type of problem can be overcome by 
pressing the "Cancel" button on the front panel of your printer, however you should make 
sure that the printer is processing the plot you want to cancel.



Color as Grayscale
Using this setting the colors in your drawing are converted to shades of gray.    Use Color as 
Grayscale when you want the colors in a drawing to be printed using shades of gray.

Color as Grayscale is the default setting with a monochrome printer.

You may find the Lightness setting to be particularly useful when you use this setting.



Color intensity using the print "Color as Grayscale" setting
When using the driver's "Color as Grayscale" setting you may see that some colors are 
printed as black and not as a shade of gray.    Some applications send a black color value for 
some objects when they detect a non-color device driver.        



Convert colors to pure Black
Your drawing will be printed using only black and white.    All the non-white colors in your 
drawing will be printed using black.    This setting is not recommended if you drawing has 
color photographs or images in it. 



Copies
The Copies setting in the Options dialog box lets you make up to 99 copies of each 
drawing. To change the Copies setting, type in a new number between 1 and 99, inclusive.



Custom paper size
If the paper size you have chosen in 
your software application is not listed in
the Setup dialog box, or if you're 
producing a long-axis print, you should 
use the Custom paper size box to 
enter its dimensions.

The dimensions you enter should be the
same as those used by your 
application*.

The Units drop-down list allows you to 
choose between 'inch' and 'mm' to 
allow you to enter dimensions in the 
measuring system of your choice.

Use Width to specify the width (shorter dimension) of your custom-size paper or the width 
of the paper for your long-axis print.
NOTE:    Always enter the smaller dimension for Width.

Use Length to specify the length (longer dimension) of your custom-size paper or the length
of the paper for your long-axis print.
NOTE:    Always enter the larger dimension for Length.

The Custom option in the Paper Size drop-down list will display the dimensions of the 
custom size you enter here.

*If the Paper Size option you select in the Setup dialog box does not match the size of the 
paper you have chosen in your software application, your printed drawing may be incorrectly
placed on the paper.

Associated topics:
Custom paper size limits 
How to calculate a printable area 
Long-axis prints 
Printer margin settings using this driver 

To print this or any other help topic, choose Print Topic from the File menu in the Help 
window.



Custom paper size limits
When entering Width and Length values for a Custom paper size, refer to the following 
table for the range of acceptable values (inclusive), which are based on the printer type you 
selected in this driver.

Driver-selected/Printer Type Width Range Length Range*
HP DesignJet 200 Printer (C3180A)
HP DesignJet 220 Printer (C3187A)
HP DesignJet 230 Printer (C4694A)
HP DesignJet 250C Printer (C3190A)

8.3 to 24.6 in
(211 to 625

mm)

8.3 to 64.0 in
(211 to 1625

mm)
HP DesignJet 200 Printer (C3181A)
HP DesignJet 220 Printer (C3188A)
HP DesignJet 230 Printer (C4695A)
HP DesignJet 250C Printer (C3191A)

8.3 to 36.1 in
(211 to 917

mm)

8.3 to 64.0 in
(211 to 1625

mm)
HP DesignJet 600 Printer (C2847A)
HP DesignJet 650C Printer 
(C2858A/B)
HP DesignJet 750C Printer (C3195A)

8.3 to 24.6 in
(211 to 625

mm)

8.3 to 109.2 in
(211 to 2773

mm)

HP DesignJet Printer (C1633A/B)
HP DesignJet 600 Printer (C2848A)
HP DesignJet 650C Printer 
(C2859A/B)
HP DesignJet 750C Printer (C3196A)
HP DesignJet 755CM Printer 
(C3198A)

8.3 to 36.1 in
(211 to 917

mm)

8.3 to 109.2 in
(211 to 2773

mm)

*    If your application has a maximum length value, your prints will be limited to that 
value even if you enter a larger "Length" value in the driver. 

 
Associated topics:

How to calculate a printable area 

To print this or any other help topic, choose Print Topic from the File menu in the 
Help window.



Custom Size
The Custom option in the Paper Size drop-down list box allows you to enter a paper size 
that is not listed among the other Paper Size options.

Associated topics:
Custom paper size 
Long-axis prints
Paper Sizes dialog box



Customer Support
If you need help while configuring this driver and your questions are not answered by this 
online help system, you can either contact your local authorized HewlettPackard dealer, or 
customer support organisation for help.    See below for details.

 US Support Resources

Resource Support provided Phone 
number

Hours of 
operation.

HP Customer
Support 
Center

Technical support
with setup, 
operation and 
repair 
information.

(208) 323-
2551

M/Tu/Th/F:
7 a.m. - 6 
p.m. (MST)

Wednesday:
7 a.m. - 4 
p.m.
(MST)

 European Support Resources

Resource Support 
provided

Phone 
number*

Hours of 
operation.

European 
Customer 
Support 
Center 
(ECSC)

Language 
spoken:

English
Dutch
French
German
Norwegian
Danish
Finnish
Swedish
Italian
Spanish

+31
/20-682 8291
/20-681 6473
/20-681 8260
/20-681 7174
/20-682 0094
/20-681 6171
/20-681 1214
/20-681 8025
/20-581 3318
/20-581 3319

M/Tu/Th/F:
8:30 a.m. - 
6 p.m. (CET)

Wednesday:
8:30 a.m. - 
4 p.m.
(CET)

* In some countries calls can be made at a domestic rate, contact your 
local authorized HewlettPackard dealer for these special numbers.

 Asia-Pacific Support Resources

Resource Support 
provided

                                    
Phone/Fax 
number

Hours of 
operation.

HP Fulfilment
Service

Latest drivers. Australia:
Tel: (612) 565
              6099
Fax: (612) 519

Normal 
office hours 
in the 
applicable 



                  5631

Singapore:
Tel: (65) 740 
              4477
Fax: (65) 740
                4499

country.

For telephone support in the AsiaPacific region other than the service listed 
above, initially refer to your printers documentation then contact your local
HP dealer.

To print this or any other help topic, choose Print Topic from the File menu in the Help 
window.



Defaults - Color Control dialog box
The Defaults button brings all settings back to the original factory defaults.

1) HP DesignJet 250C, 650C (B-series), 750C & 755CM with Color as grayscale selected:
Defaults:

Convert colors to pure 
Black

Off

Halftoning Scatter
Lightness Mid setting

2) HP DesignJet 250C, 650C (B-series), 750C & 755CM with Manual color selected:
Defaults:

Printed Color 
Control
Text: Vivid Color
Graphics: Vivid Color
Photos:    Vivid Color
Halftoning
Text: Scatter
Graphics: Scatter
Photos:    Scatter
Lightness Mid setting
PANTONE®* Colors Off
* Pantone, Inc.'s check-standard trademark for color.

3) HP DesignJet 230
Lightness Mid setting
Halftoning Scatter

4) HP DesignJet 200, 220, 600 & 650C (A-series)
Lightness Mid setting
Halftoning Pattern

Defaults - Options dialog box
1) HP DesignJet 750C & 755CM

Color Automatic
Print Quality Normal (final)
Paper Type Coated Paper
Copies 1
Process 
document...

...In printer

2) HP DesignJet 250C & 650C (B-series)
Color Automatic
Print Quality Normal (final)



Paper Type HP special 
paper

Copies 1
Process 
document...

...In printer

3) HP DesignJet 650 (A-series)
Color Normal
Print Quality Normal (final)
Copies 1
Process 
document...

...In printer 

4) HP DesignJet 200, 220, 230, & 600
Color Color as Grayscale
Print Quality Normal (final)
Copies 1
Process 
document...

...In printer

Font support and recommendations
The method of font generation the printer uses depends on which font you've selected in 
your document or drawing.

The following table summarizes this driver's font support and recommendations.

WINDOWS 3.1 FONT SUPPORT
Font Type Selected in Document/Drawing All HP DesignJet

printers:
Any standard Windows vector font
(Modern, Roman, Script)

Supported

Any standard Windows raster font
(Courier, Helv, Symbol, System, Terminal, Tms 

Rmn)

Supported/
Not recommended

Adobe Type Manager (ATM) fonts Supported

TrueType fonts Supported/
Recommended

Intellifont Type fonts
(TypeDirector, Intellifont-for-Windows)

Not supported

Any other type of font Not supported

To print this or any other help topic, choose Print Topic from the File menu in the Help 
window.



General Information
The following topics are not specific to a particular application.    If your specific application is
not covered by this help system, this information may be useful to help you understand its 
behavior.

Canceling a print from your application 
Color intensity using the print "Color as Grayscale" setting
Long-axis printing
Printing areas with gradient shading
Printing lines
Some applications do not work with large paper sizes
Some applications have an overriding orientation setting 
Users of paint and image-processing applications 
Using the "Process document in computer" option



Halftoning
Primary printer colors are cyan, magenta, yellow, red, green, blue and black.    All other 
colors are produced by using these primary colors and white space.    The eye mixes these to
produce other colors and shades.    The method used by your printer to produce non-primary 
colors is user selectable through the Halftoning setting, which is either: Scatter, Pattern or 
Cluster.

The choice is usually a matter of personal preference.    (See Associated topics below.)

Scatter produces a smooth appearance by randomly distributing the ink.
(Scatter is not available with some devices.)

Use the Scatter setting for: Complex graphic images.
Photographic images.
Scanned images.
Images with gradient fills.
Business graphics.

Pattern will give a uniform distribution of ink.    Sometimes it will produce a noticeable 
geometric pattern.    Pattern was the only halftoning option in older versions of this driver.    
You could select Pattern in order to retain consistency with drawings produced using one of 
these older versions of the driver.

Use the Pattern setting for: Colored text.
Line graphics.
Free-hand images.
Clip art images.
Desktop publishing images.

Cluster halftoning places dots of ink in clusters to produce complex graphics and 
documents which are to be photocopied.
(Cluster is not available with some devices.)

NOTE:    Thin lines and small type sizes (less than 18 points) in non-primary colors may 
not print well.    If your output is unsatisfactory, choose primary colors for these objects 
and be sure to set Printed Color Control of Graphics to 'No Adjustment' otherwise 
your chosen primary color may again be printed as a non-primary color.

Associated topics:
Examples of halftoning



How to calculate a printable area

The dimensions of the printable area of a particular sheet of paper can only be calculated 
when you know how it will be loaded into the printer, in either portrait or landscape 
orientation.    You can then apply the printer margin dimensions to calculate the printable 
area's length and width.    
Note: that the paper's orientation does not necessarily correspond to the orientation of the 
drawing in your application, there are occasions when your drawing will be rotated by 90 
degrees before it is printed, hence the width of the drawing in your application is printed 
along the length of your loaded paper. See special case topic listed below.

The dimensions of the printable area can be calculated as follows:

Printable area length:
= Loaded Paper length - (Top + Bottom margins) 
= Loaded Paper length - (17mm + 17mm)
= Loaded Paper length - (.67in + .67in)

Printable area width :
= Loaded Paper width - the two side margins
= Loaded Paper width - (5mm + 5mm) 
= Loaded Paper width - (.20in + .20in)

Associated topics:
Printable areas for some standard paper sizes 
Special case



HP DesignJet printer notes
When using one of these printers, please keep the following notes in mind:

* Always select pen parameter source = "Software."

Be sure to set the front panel's source of pen parameters to "Software" to ensure that 
this driver will work correctly.

To check the printer's front panel setting, select "Source" from the Pen Parameters menu.
If the front panel says, "Source=Software," you don't need to change anything.    If it says
anything else, press Enter, use Down Arrow to scroll to "Software," then press Enter.

* Colored objects are printed with gray values.

Because the "source of pen parameters" is always set to "Software" when using this 
driver, the printer's front panel pen settings are ignored.    The driver will convert a 
colored object to black or to one of the printer's shades of gray.    

* Rasterized drawings can't be rotated from the printer's front panel.

Due to rotate buffer memory limitations, rasterized drawings (e.g., drawings with heavy 
area fill and shading that you've scanned into your application) can't be rotated using the
front panel Rotate feature.    If you want to rotate a print that contains rasterized data, we
recommend rotating it from within your application.

Note: Your drawing contains rasterized data if, it contains a bitmap, if you have used raster 
fill patterns, or if it contains text.



HP DesignJet 200, 220, 230 and 250C printer notes
When using one of these printers, please keep the following notes in mind:

*    ATM text is not printed as expected (HP DesignJet 250C only).

The color of ATM text sent as graphics is enhanced according to the Graphics setting in 
the driver and not as Text.    This driver no longer requires the ATM Control Panel to be 
set as "Print ATM fonts as graphics", instead you are recommended to select "Use pre-
built or resident fonts".    This setting will avoid any differences in text color and will 
provide performance benefits.    

* Always select pen setting source = "from software."

Be sure to set the printer's source of pen parameters to "from software" to ensure that 
this driver will work correctly.

To check the printer's setting, load a sheet of printing paper and print a setup sheet.    
The current pen settings source is indicated on this sheet.    If "from software" is already 
the current setting you don't need to change anything.    If "from these tables" is the 
current setting, you need to fill in the "from software" oval and load the setup sheet back
into the printer as indicated on the sheet itself.

* Colored objects are printed with gray values when "Color as grayscale" is 
selected
(HP DesignJet 200 and 220 default setting)

Because the "source of pen parameters" is always set to "Software" when using this 
driver, the printer's front panel pen settings are ignored.    The driver will convert a 
colored object to black or to one of the printer's shades of gray.    

* Rasterized drawings can't be rotated using the set up sheet.

Due to rotate buffer memory limitations, rasterized drawings (e.g., drawings with heavy 
area fill and shading that you've scanned into your application) can't be rotated using the
setup sheet "Rotate" feature.    If you want to rotate a print that contains rasterized data, 
do not use the printer's rotate feature and rotate it from within your application.

Note:    Your drawing contains rasterized data if: it contains a bitmap, you have used 
raster fill patterns, or it contains text.



HP DesignJet 600, 650C, 750C & 755CM printer notes
When using one of these printers, please keep the following notes in mind:

*    ATM text is not printed as expected (HP DesignJet 650C (C2858B and C2859B), 
750C and 755CM).

The color of ATM text sent as graphics is enhanced according to the Graphics setting in 
the driver and not as Text.    This driver no longer requires the ATM Control Panel to be 
set as "Print ATM fonts as graphics", instead you are recommended to select "Use pre-
built or resident fonts".    This setting will avoid any differences in text color and will 
provide performance benefits.    

* Always select pen parameter source = "Software."

Be sure to set the front panel's source of pen parameters to "Software" to ensure that 
this driver will work correctly.

To check the printer's front panel setting, select "Palette" from the Pen Settings menu.    If
the front panel says, "Palette=Software," you don't need to change anything.    If it says 
anything else, press Enter, use Down Arrow to scroll to "Software," then press Enter.

* Colored objects are printed with gray values (DesignJet 600 only).

Because the "source of pen parameters" is always set to "Software" when using this 
driver, the printer's front panel pen settings are ignored.    The driver will convert a 
colored object to black or to one of the printer's shades of gray.    

* Rasterized drawings can't be rotated from the printer's front panel.

Due to rotate buffer memory limitations, rasterized drawings (e.g., drawings with heavy 
area fill and shading that you've scanned into your application) can't be rotated using the
front panel Rotate feature.    If you want to rotate a print that contains rasterized data, we
recommend rotating it from within your application.

Note: Your drawing contains rasterized data: if it contains a bitmap, if you have used 
raster fill patterns, or if it contains text.

* The autorotate feature is disabled.

The HP DesignJet 600, 650C, 750C and 755CM printers have an automatic rotation 
feature that rotates prints on roll paper when rotating will conserve paper.    The 
autorotate feature is disabled when you use this printer driver.

* Expanded margins are not available.

The HP DesignJet 600, 650C, 750C and 755CM printers have an Expanded margin feature
that increases the printable area.    When you use this driver, the Expanded margin 
feature is not available.



Lightness
The Lightness setting allows you to control the lightness or darkness of your printed output.   
You might find this control useful if you're working with a scanned image in your application.

To change the Lightness setting slide the button along the scale in the direction required.

Clicking on the Defaults button resets all the settings in the Color Control dialog box to 
their default setting; the Lightness setting is reset to the middle box.

To print this or any other topic, choose Print Topic from the File menu in the Help window.



Lightness
The Lightness (gamma) adjustment lightens or darkens the printed output.    Use this to 
control the overall intensity of your image - lightest (on the left) darkest (on the right).

To change the Lightness setting slide the button along the scale in the direction required.    
For no Lightness adjustment select the darkest setting.

The Lightness (lightness/darkness) adjustment interacts with all three Printed Color 
Control options.

NOTE:    When Printed Color Control is set to 'No adjustment', Lightness has no 
effect on the pure primary printer colors (red, green, blue, cyan, magenta, yellow, black),
but will still affect non-primary colors.    To remove the effect of the Lightness control 
completely, set it to its darkest setting.

To print this or any other help topic, choose Print Topic from the File menu in the Help 
window.



Loading sheet paper into your printer
You should load sheet paper into your printer in whatever orientation you have selected in 
the driver and your application, if your application has such a setting.    Where it is possible 
to enter an orientation setting in your application make sure that it agrees with the driver 
orientation setting.    However if your paper size is so large that it is only possible to load it in
portrait orientation you must pay special attention to the margin settings.    See the 'Special 
Case' section in the 'Printer margins' settings' topic for advice on the necessary steps.

Associated topic:
Orientation
Printer margins
Special Case



Long-axis prints
The long-axis feature allows you to produce prints up to 109.2 inches (2773 mm) long with 
this driver.    Long-axis printing is possible if both the printer and the application support this 
feature.

All the Supported Printers support long-axis printing.

Note: The HP DesignJet 200, 220, 230 and 250C support long-axis printing, but long-axis 
prints are limited to 64.0 inches (1625 mm).

Below is a list of some commonly-used Windows applications that support long-axis printing. 
If your application isn't in this list, refer to your application's user guide to find out if long-
axis printing is supported.

Some applications that support long-axis printing:

Arts & Letters
CADvance
Micrografx Picture Publisher
Microsoft Project*

*    Version 3.0 of Microsoft Project supports long-axis printing, however print length is 
limited to 62 inches (1575 mm).

To produce a long-axis print, you must enter the long-axis print Length in the Paper sizes 
dialog box.    Note:Your application may require other setting changes as well; refer to your 
application user's guide for more information.

To access the Paper sizes dialog box in Windows 3.1 -

from the Program Manager window: 
open the Main window and double click Control Panel, double click Printers, and 
with your output device selected, click the Setup... button, then select More 
sizes... .    This will open the Paper Sizes dialog box, you can enter your long-axis 
print dimensions in the Custom paper size section of this dialog box.

from your application: 
select the Print setup, or similarly named option, probably in the File menu.    Check
that your output device is selected, click the Options... button and then Paper 
size... in the Options dialog box.    This will open the Paper Sizes dialog box, you 
can enter your long-axis print dimensions in the Custom paper size section of this 
dialog box.

To access the Paper sizes dialog box in Windows 95 -

from the desktop: 
click on Start, and select Settings and then click on Printers.    In the Printers 
dialog box click on your HP DesignJet printer icon with the right mouse button, and 
select Properties from the pop-up menu.    Click on the Details tab and click on the 
Setup button.    Click on the More sizes button.

from your application: 
select the Print setup, or similarly named option, probably in the File menu.    Check
that your output device is selected, click the Properties... button and then More 



sizes....    This will open the Paper Sizes dialog box, you can enter your long-axis 
print dimensions in the Custom paper size section of this dialog box.

To print this or any other help topic, choose Print Topic from the File menu in the 
Help window.



Manual Color
Manual Color is an alternative to Automatic, by using the settings in the Color Control 
dialog box you can control the colors of your printed output according to your particular 
needs.

Select Manual Color and then Color Control... to open the Color Control dialog box.



Margins - Landscape image/Landscape paper
For landscape paper and a landscape drawing, the margins are:

            

The above values are as you should enter them in your application.
They are the absolute minimum, you should not enter values less than these even if your 
application allows you to.

Associated topics:
How to calculate a printable area 
Printable areas 



Margins - Portrait image/Portrait paper
For portrait paper and a portrait drawing, the margins are:

The above values are as you should enter them in your application.
They are the absolute minimum, you should not enter values less than these even if your 
application allows you to.

Associated topics:
How to calculate a printable area 
Printable areas for some standard paper sizes 



Margins - Landscape image/Portrait paper
Special case: for portrait paper and a landscape drawing, the margins are:

For users who want to produce a landscape drawing with the largest paper size the printer 
supports.    This special case requires that you transpose the margins, as shown above: the 
margin dimension which you enter in your application as the "Top margin" should correspond
to the printer's left margin and, the "Bottom margin" dimension entered in your application 
should correspond to the printer's right margin etc, etc see table above.

For example, if you have an E-size DesignJet 600 printer and you want to produce an E-size 
print in landscape orientation, you would enter the following margin settings in your 
application:

Top = 5.0 mm (.20 in) Bottom = 5.0 mm (.20 in)
Left = 17.0 mm (.67 in) Right = 17 mm (.67 in)

They are the absolute minimum, you should not enter values less than these even if your 
application allows you to do so.

Associated topics:
How to calculate a printable area 
Printable areas 



Match Screen
Match Screen provides the closest printer-to-screen color matching.    If selected, you 
should have performed screen calibration by clicking the Calibrate Screen... button.

Associated topics:
Calibrate Screen  



In printer/computer...

You are recommended to always print using the 'In printer' setting whenever it is possible.  
Only if you see an 'Out of memory' message on the printer for a particular print should you 
return to this dialog box and enable the 'In computer' option.    By doing so you can ensure 
that your drawing will always be printed by the printer, however the time taken may be 
considerably longer than that if it were possible to print using the 'In printer' option.

DON'T FORGET if you use the 'In computer' option to re-select 'In printer' when you print a 
different drawing, your printer may have enough memory to print it and you will make a 
saving in time by disabling 'In computer'.



More sizes
This button opens the Paper Sizes dialog box. 



No Adjustment
Select No Adjustment if you want the colors selected in your software application passed 
through to the printer without adjustment*.

*For no Lightness (gamma) adjustment select the darkest setting.



Normal
Available only on the HP DesignJet 650C (A-series) printers.

Use this setting to get printed output using the colors in your drawing.



Notes to ATM font users

HP DesignJet 250C, 650C (C2858B and C2859B only), 750C, 755CM.

1) ATM fonts can be sent to the printer as graphics.    Which means that the settings you 
have selected for Graphics in the Color Control dialog box i.e. Printed Color 
Control and Halftoning, will be used to control its appearance and not those selected
for Text.    As a result you may see a difference in your printed output between text and
text using ATM fonts.

2) You are recommended to select "Use pre-built or resident fonts" from the ATM Control 
Panel, this setting will avoid differences in text color and improve perfromance.

 3) If your document uses vector fonts (i.e. Modern, Roman, Script) and you have Adobe 
Type Manager switched on, you may see that some of the fonts in your document will 
be substituted using ATM fonts.

      
 4) If your document uses a font that is not installed on your system it will be substituted

using a similar one, as follows:
if ATM is on, using an ATM font.
if ATM is off, using a TrueType font.



Orientation
The Orientation setting indicates which way the paper you selected in Paper Size will be 
oriented: 

Portrait Landscape

Portrait means the 
paper is taller than it 
is wide when you view
the printed drawing 
upright. 

Landscape means the 
paper is wider than it is
tall when you view the 
printed drawing 
upright.

To change the Orientation setting, click the option button representing the orientation you 
want. The icon to the left of the option buttons illustrates the selected Orientation.

Associated topics:
General Information
Printer margin settings using this driver 

To print this or any other help topic, choose Print Topic from the File menu in the Help 
window.



Oversize

+

Select Oversize, AND select an oversize option
here.

Using the 'oversize' feature you can print images which have the same dimensions as a 
standard size, hence the printer requires an 'oversized' piece of paper to print the required 
results.    The examples below illustrate the results when printing an image which is 11 x 17 
ins (the same dimensions as ANSI B.)    

Image size
in

application

Loaded paper size
and 'Paper Size'

setting in 
Print Setup dialog

box.

Result

11 x 17 ins ANSI B (11 x 17 ins) Clipped image surrounded by printer
margins - printer unable to print all 
of image due to the printers need to 
leave margins blank.

11 x 17 ins Oversize: ANSI B (11 
x 17 ins + either 
Landscape or Portrait 
margins.)

All of image printed, surrounded by 
printer margins.

11 x 17 ins Roll or sheet equal to 
or larger than 
Oversize: ANSI B.(11 
x 17 ins + either 
Landscape or Portrait 
margins.)

All of image printed, surrounded by 
printer margins - depending on size 
of paper loaded in printer, there will 
be unused blank paper.



Ensure that your loaded paper has 
dimensions which are at least equal to
the standard size + printer margins..

For example:
to print an ANSI A sized image 
your loaded paper needs to be at 
least ANSI A sized plus the margins
required by the printer.    See 
opposite: A size + printer margins = Oversize: 

ANSI A

Pantone
Available only with the HP DesignJet 650C (B-series), 750C and 755CM.

If you want to have simulated Pantone colors in your printer output you must select 
Pantone Colors.    By selecting Pantone Colors you ensure that colors, which are 
designated as Pantone colors by your application, are not passed through the Printed Color 
Control and Halftoning color enhancement processes.    They will instead be sent directly to 
your printer using color co-ordinates which will simulate the selected Pantone color.

For further information regarding the use of PANTONE simulated colors refer to the 
application note which was packaged with your printer*.

* HP DesignJet 650C (B-series) - "Using PANTONE Simulated Colors with your HP Plotter" 
    or
    HP DesignJet 750C and 755CM -    "HP Color Management Kit - User's Guide".

* Pantone, Inc.'s check-standard trademark for color © Pantone, Inc., 1988



Paper Size list
The sizes listed in this drop-down list are controlled in three ways:

-    the currently selected Paper Source,
-    options selected in the Paper sizes dialog box and, 
-    by the type of printer you are using 

(i.e. 'E' size paper will not be listed if you have a 'D' size printer.)

If the size you want is not listed, use the More sizes... button to open the Paper Sizes 
dialog box and 'check' the appropriate paper standards option.

Associated topics:
Custom paper size
Long-axis prints
More sizes...
Paper sizes dialog box



Paper Source
The Paper Source setting refers to the source of the paper you've loaded in your printer.    It
is either a single sheet or a roll.

The list of roll size options is based on your selected printer type.

If you've loaded a single sheet, select Sheet Feed.

If you've loaded a roll, be sure to select the roll size you've loaded. If your roll size isn't 
listed, choose Sheet Feed.



Paper Type List

Depending on the printer you are configuring, the Paper Type drop-down list lets you select
from the following paper types:

HP DesignJet 750C & 
755CM
Paper Type options:

HP DesignJet 250 & 650 (B-
series)
Paper Type options:

Coated Paper(2, 6) HP Special Paper
Opaque Bond Other(5)
High-Gloss Film (2)
Semi-Gloss Photo
High-Gloss Photo( 7)

The appearance of the colors which are printed are dependent on the type of paper they are 
printed on and the color options(1) you have selected.    If you are using PANTONE®* 
Colors(3) in your image or you want your printed colors to closely match those you see on-
screen(4), we recommend that you load one of the Pantone certified medias and set the 
driver Paper Type setting to match.

Note: 
1) The default color option Vivid color will enhance the appearance of printed colors.
2) This media is Pantone certified.    
3) PANTONE Colors generated by the HP DesignJet 650C, 750C and 755CM are four-color process simulations and 
may not match PANTONE-identified solid color standards.
4) Use the Match Screen setting in the Color Control dialog box.
5) If you are not using HP Special Inkjet Paper we recommend that you select Other as your paper type.    Using 
this setting:    a) the PANTONE Colors and Printed Color Control settings, in the Color Control dialog box 
assume generic paper characteristics, and b) the recommended drying times will not be valid.
6) If you are using "HP Heavyweight Coated Paper", select this Paper Type list option.
7) If you are using "HP Premium-Gloss Photo Paper", select this Paper Type list option.

* Pantone, Inc.'s check-standard trademark for color.

You should always select the type of paper that you have loaded in the printer in order to get
the best printed quality and the best color characteristics.    If the paper type setting does 
not correspond to the type of paper you have loaded the quality of the printed image may 
be degraded and the color fidelity may be impaired.



Printable areas
Click on any of the listed paper standards to see a list of printable areas for the most 
common paper sizes.

Paper standards:
ANSI 
Architectural
DIN 
ISO 
JIS 

Associated topics:
Custom paper size limits 
How to calculate a printable area 
Printer margin settings using this driver 

To print this or any other help topic, choose Print Topic from the File menu in the Help 
window.



Printable Areas - Architectural
Printable area (width x height) by orientation of

drawing
HP DesignJet 
series printers
only

Size 
(orientation) 
of loaded 
paper

Inches:
landscape
portrait

millimeters:
landscape
portrait

Architectural A (portrait) - 8.61 x 10.66 - 219 x 271
A (landscape) 11.61 x 7.66 - 295 x 195 -
B (portrait) - 11.61 x 16.66 - 295 x 423
B (landscape) 17.61 x 10.66 - 447 x 271 -
C (portrait) - 17.61 x 22.66 - 447 x 576
C (landscape) 23.61 x 16.66 - 600 x 423 -
D (portrait) 34.66 x

23.61(1)
23.61 x 34.66 880 x 600 (1) 600 x 880

D (landscape)(2) 35.61 x 22.66 - 904 x 576 -
E1 (portrait) 40.66 x 29.61

(3)
29.61 x 40.66 1033 x 752

(3)
752 x 1033

E (portrait) 46.66 x 35.61
(3)

35.61 x 46.66 1185 x 904
(3)

904 x 1185

(1) For D/A1-size devices only, requires the use of the Special case circumstances.
(2) For E/A0-size devices only.
(3) For E/A0-size devices only, requires the use of the    Special case circumstances.



Printable Areas - ANSI
Printable area (width x height) by orientation of

drawing
HP DesignJet 
series 
printers only

Size 
(orientation)
of loaded 
paper)

Inches:
landscape
portrait

millimeters:
landscape
portrait

ANSI A (portrait) - 8.11 x 9.66 - 206 x 245
A (landscape) 10.61 x 7.16 - 269 x 182 -
B (portrait) - 10.61 x

15.66
- 269 x 398

B (landscape) 16.61 x 9.66 - 422 x 245 -
C (portrait) - 16.61 x

20.66
- 422 x 525

C (landscape) 20.61 x 15.66 - 549 x 398 -
D (portrait) 32.66 x 21.61

(1)
21.61 x
32.66

830 x 549 (1) 549x 830

D (landscape) (2) 33.61 x 20.66 - 854 x 525 -
E (portrait) 42.66 x 33.61

(3)
33.61 x
42.66

1084 x 854
(3)

854 x 1084

* not DesignJet 2xx series

(1) For D/A1-size devices only, requires the use of the Special case circumstances.
(2) For E/A0-size devices only.
(3) For E/A0-size devices only, requires the use of the    Special case circumstances.



Printable Areas - DIN
Printable area (width x height) by orientation of

drawing
HP DesignJet 
series printers
only

Size/
orientation 
of loaded 
paper)

Inches:
landscape
portrait

millimeters:
landscape
portrait

DIN C4 (portrait) - 8.62 x 11.41 - 219 x 290
C4 (landscape) 12.36 x 7.68 7.68 x 12.36 314 x 195 -
C3 (portrait) - 12.36 x

16.70
- 314 x 424

C3 (landscape) 17.64 x 11.42 - 448 x 290 -
C2 (portrait) 24.7 x 17.64 (1) 17.64 x

24.17
614 x 448

(1)
448 x 614

C2 (landscape) 
(2)

25.12 x 16.70 - 638 x 424 -
C1 (portrait) (2) - 25.12 x

34.76
- 638 x 883

C1 (landscape) 35.71 x 24.17 - 907 x 614 -
C0 (portrait) 49.72 x 35.71

(3)
35.71 x
49.72

1263 x 907
(3)

907 x 1263

(1) For D/A1-size devices only, requires the use of the Special case circumstances.
(2) For E/A0-size devices only.
(3) For E/A0-size devices only, requires the use of the    Special case circumstances.



Printable Areas - JIS
Printable area (width x height) by orientation of

drawing
HP DesignJet 
series printers
only

Size 
(orientation) 
of loaded 
paper

Inches:
landscape
portrait

millimeters:
landscape
portrait

JIS B4 (portrait) - 9.72 x 12.99 - 247 x 330
B4 (landscape) 13.94 x 8.78 - 354 x 223 -
B3 (portrait) - 13.94 x

18.94
- 354 x 418

B3 (landscape) 19.88 x 12.99 - 505 x 330 -
B2 (portrait) 27.32 x 19.88

(1)
19.88 x
27.32

694 x 505
(1)

505 x 694

B2 (landscape) 
(2)

28.27 x 18.94 - 718 x 481 -
B1 (portrait) 39.21 x 28.27

(3)
28.27 x
39.21

996 x 718
(3)

718 x 996

(1) For D/A1-size devices only, requires the use of the Special case circumstances.
(2) For E/A0-size devices only.
(3) For E/A0-size devices only, requires the use of the    Special case circumstances.



Printable Areas - ISO
Printable area (width x height) by orientation of

drawing
HP DesignJet 
series printers
only

Size 
(orientation)
of loaded 
paper)

Inches:
landscape
portrait

millimeters:
landscape
portrait

ISO A4 (portrait) - 7.87 x 10.35 - 200 x 263
A4 (landscape) 11.30 x 6.93 - 287 x 176 -
A3 (portrait) - 11.30 x

15.20
- 287 x 386

A3 (landscape) 16.14 x 10.35 - 410 x 263 -
A2 (portrait) - 16.14 x

22.05
- 410 x 560

A2 (landscape) 23.00 x 15.20 - 584 x 386 -
A1 (portrait) 31.77 x 23.00

(1)
23.00 x
31.77

807 x 584
(1)

584 x 807

A1 (landscape) 
(2)

32.72 x 22.05 - 831 x 560 -
A0 (portrait) 45.47 x 32.72

(3)
32.72 x
45.47

1155 x 831
(3)

831 x 1155

B4 (portrait) - 9.45 x 12.56 - 240 x 319
B4 (landscape) 13.50 x 8.50 - 343 x 216 -
B3 (portrait) - 13.50 x

18.35
- 343 x 466

B3 (landscape) 19.29 x 12.56 12.56 x
19.29

490 x 319 319 x 490

B2 (portrait) 26.50 x 19.29
(1)

19.29 x
26.50

673 x 490
(1)

490 x 673

B2 (landscape) 
(2)

27.45 x 18.35 18.35 x
27.45

697 x 466 466 x 697

B1 (portrait) 38.03 x 27.45
(3)

27.45 x
38.03

966 x 697 (3) 697 x 966

(1) For D/A1-size devices only, requires the use of the Special case circumstances.
(2) For E/A0-size devices only.
(3) For E/A0-size devices only, requires the use of the    Special case circumstances.



Notes on the HP DesignJet printer series
After reading the topics about font support and margin settings (which apply to all printer 
types supported by this driver), please read one of the subsequent sections about your 
specific printer type.

All printers:
Font support and recommendations
Printer margin settings using this driver
Supported Printers 

Specific printers:
HP DesignJet printer notes
HP DesignJet 200, 220, 230 and 250C printer notes
HP DesignJet 600, 650C, 750C and 755CM printer notes

Printer margin settings using this driver
Select the diagram which matches your circumstances and click on "Margins" to see an 
explanation of the margin settings when using this driver.    (Some of the margin settings are
different when you're not using this driver.)    For best printing results, make sure the margin 
settings in your application match the driver's margin settings for the selected printer type.   
Also, be sure to read the "Special Case" topic.

Portrait image/Paper
loaded in portrait:

Margins

Landscape image/Paper
loaded in landscape:

Margins

Landscape image/Paper
loaded in portrait:

Margins*

*SPECIAL CASE: For users who want to produce a landscape print with the largest paper 
size their printer supports.

Associated topics:
How to calculate a printable area 
Printable areas for some standard paper sizes 

To print this or any other help topic, choose Print Topic from the File menu in the Help 
window.



Printer Type 
During the installation of this printer driver you were asked to choose from a list of printer 
types. Each printer type that you chose has been added to the list of printer types that 
Windows can use.    This list of installed printer types is displayed in several dialog boxes; in 
many cases the list box is called: Installed Printers or Specific Printer. If you want to use
a printer type that isn't listed in these boxes, you'll need to install it from the driver 
installation disk (installation instructions are on the disk label).

To change the selected printer type (displayed in the title bar of the Setup dialog box), go to
the File menu and select the menu item used to configure printers; in most cases this menu
item will be Printer Setup.    This dialog box contains a list of printer types.    Simply click on
the name of the printer type you want to use. This dialog box will include only those you 
selected at installation time.

Associated topics:
Supported printers

To print this or any other help topic, choose Print Topic from the File menu in the Help 
window.



Printed Color Control
Printed Color Control lets you individually control the appearance of: colored text, 
business graphics and photographs (scanned images) in one of three ways:

Vivid Color provides clear and vivid color output. There may be a slight sacrifice in hue 
on some images. This is the default setting.

Match Screen provides the closest printer-to-screen color matching. If selected, you 
should have performed screen calibration by clicking the Calibrate Screen... button.

Select No Adjustment if you want the colors selected in your software application 
passed through to the printer without adjustment*.

The Lightness (lightness/darkness) control enables you to adjust the overall lightness and 
darkness of the image.

* For no Lightness (gamma) adjustment select the darkest setting.

If you decide to select your own Printed Color Control settings you may find it necessary 
to experiment with different color-option combinations to find the settings you need for 
different printing situations.

Associated topics:
Automatic
Calibrate Screen  

To print this or any other help topic, choose Print Topic from the File menu in the Help 
window.



Printing areas with gradient shading
      

Problem:    Black lines appear in areas filled with gradient shading.

      If you see this problem use the driver's "Process document in computer" setting.



Printing lines
Potential problems:

a) The number of dashes that make up a dashed line changes with the angle of the line.    If
you see this problem and would like to avoid it use the driver's "Process document in 
computer" setting.

b) Lines which are composed of dots and/or dashes may display the background color in 
the foreground area.    To solve this problem use the driver's "Process document in 
computer" setting. 



Print Quality
The Print Quality drop-down list box offers the following three quality levels:

Enhanced (best) produces the highest print quality.    It's available with all of the HP 
DesignJet series except the HP DesignJet and HP DesignJet 200.

Final (normal) produces very good print quality.    Its printing speed is a little faster than
that of the Enhanced mode.    Final is the highest quality available for the HP DesignJet 
and HP DesignJet 200.

Draft (fast) has the fastest printing speed, but has the lowest quality.    Use it when 
speed is more important than quality.

All HP DesignJet printers (except HP DesignJet 230, 250C, 750C and 755CM)
Please note that each time you send a print, the printer's quality level setting is changed to 
match this Print Quality setting. This means that anyone who 1) is networked to your 
printer and 2) doesn't have a printer driver with a print quality setting will be affected by the
change caused by your print.



Readme.txt
                          Readme File for the Hewlett-Packard HP-GL/2 Windows Driver

Product name:
HP Printer Driver
(HP-GL/2 and HP RTL)

                                  for Microsoft Windows.

Version number:  v2.1

Language(s) supported:      English, French, Italian, German, Spanish

Products supported:    
HP DesignJet
HP DesignJet 200
HP DesignJet 220
HP DesignJet 230
HP DesignJet 250C
HP DesignJet 600
HP DesignJet 650C
HP DesignJet 750C
HP DesignJet 755CM

Installation instructions: See detailed instructions at the end of this file.

Platform requirements:  MS Windows 3.1 or later.    MS Windows 95

SOFTWARE APPLICATION NOTES:
The following section details late-breaking news regarding the use of this driver with some 
popular software applications.

Aldus Freehand 4.0 users
If the user works with another application while Freehand is printing, the printing may be 
aborted.
To avoid this problem, do not use Windows until the Freehand printing has finished.

Aldus PageMaker version 5.0
Problem:    The colors for some area fills are converted to solid colors.
Solution: Update to version 5.0a of the program.

Corel application users
In CorelDraw 5.00.D1 and earlier versions, a floating point division by 0 exception can occur 
if you try to plot 5EFFECTS.CDR and others drawings with A1 and landscape settings. This 
problem has been fixed in any newer version of CorelDraw. Upgrade to CorelDraw! 5.00.E2 
or any later version (if you are unsure about your current CorelDraw! version, click on 
"About" in "Help").

Lotus 123 users
When using this application you may see characters which overlap each other on the right 
side of the page.      Try using the 'Process document in computer' option. It may fix the 
problem. 



Micrografx Picture Publisher 5.0
When printing from this application, set the checkbox 'Use printer screening' in the print 
dialog box in order to get maximum quality color reproduction from your HP DesignJet 
printer. If you don't select this option and you print a long axis plot, you may see a black 
rectangle covering all, or part, of your drawing. 

Non-application-specific information:

(1)    Using 'Process document in computer' option
If this processing mode is used with the printer connected to a local PC port, using the Print 
Manager spooler is strongly recommended. 

(2)    TRUE TYPE FONTS: problems with italic, rotated characters
If you use italicized and rotated text in your document and your printed output is not the 
same as you can see on your screen, check that you are using a font which is an actual 
TrueType font. 
Workaround (a): choose an TrueType Italic Font which is listed in the Control Panel's "Fonts" 
dialog box.
Workaround (b): use the 'Process document in computer' option when you print.

(3)    Excessive "Application lock-out" time (Win 95)
If you find that you are locked out of your application for an excessive amount of time when 
you send a file to be printed, it could be because "Enhanced MetaFile spooling" has been 
disabled.    This problem can be caused by an old version of Adobe Type Manager (ATM), 
even if it is disabled.    We recommend that you upgrade to the latest version of ATM.
      

INSTALLATION INSTRUCTIONS

 IMPORTANT 
                  No other applications should be running when you install this driver.

Quick Installation from Windows 3.1

1. Insert the driver disk into the A (or other) drive of your computer.
2. In the Program Manager, select File and then Run...
3. On the Command Line, type a:\install and click on OK.
4. Select the desired configuration in the Installation dialog box and click on OK.

Quick Installation from DOS (Windows not running)

1. Insert the driver disk into the A (or other) drive of your computer.
2. Type:        win a:\install.
3. Select the desired configuration in the Installation dialog box and click on OK.

Standard Windows 3.1 Installation

 1. Insert the driver disk into the A (or other) drive of your computer.
 2. Open the Program Manager in MS Windows.
 3. In the Program Manager, select Main.
 4. In Main, select Control Panel.
 5. In Control Panel, select Printers.
 6. In the Printers dialog box, click on Add Printer >>.



 7. In the List of Printers list box, double click on the Unlisted Printer entry.
 8. In the Add unlisted printer dialog box, double click on the A: (or other) drive in the 
Directories list box.
 9. Double click on the model name of the printer you want to install in the "Printer model" 
list box.
10. Click on Use Print Manager.
11. In the Printers dialog box, click on Connect.
12. In the Printers - Connect dialog box, click on the desired port.
13. In the Printers - Connect dialog box, change both the Device Not Selected and 
Transmission Retry timeouts to 900 and click on Fast Printing Direct to Port. Click on OK
14. Double click on the desired installed printer so it appears in the Default Printer box. Click
on Close.

Standard Windows 95 Installation

The driver you have received was written for a pre-release version of Windows 95.    For this 
reason you are recommended to contact customer support to ensure that you have the 
latest version of the driver.    Refer to the Customer Support section on page 7 of this driver's
"Installation Guide" for details.

Note that, unless stated otherwise, all mouse clicks in the following procedure assume you 
are using the left mouse-button.

1. With the "HP Printer Driver (HP-GL/2 and HP RTL) for Microsoft Windows 3.1 and Windows 
95" disk inserted in your floppy drive and with Windows 95 running, click on Start, select 
Settings and then Printers to open the Printers dialog box.

2. Double-click on the Add Printer icon to open the Add Printer Wizard dialog box.

3. Follow the steps displayed on your screen.    Below is a series of questions which, 
depending on your system configuration, you may be requested to answer.

How is this printer attached to your computer? 

      Select: 
      Local printer if the printer is connected to your computer by a cable running directly 
between them.    
      
      Network printer if the printer has a network option installed, such as "The HP JetDirect 
Network Interface", and you will use it to communicate with your printer. 

Do you print from MS-DOS-based programs? 
 
    We recommend that you select No, select Yes only in the case where you have an MS-DOS 
driver which can print to a HP DesignJet series printer.

Would you like to print a test page? 

      We recommend that you select Yes.    

      By printing a test page you will test the communications link between your system and 
the printer.

4. At the end of the installation procedure you will see the Software Application Notes 
section of the driver's help system.    You are recommended to read the sections which apply 



to the applications which you use, after which you can close the help file and you will be 
returned to the Windows' 95 "Add Printer Wizard" dialog box.

5. Remove the driver installation disk. 



Some applications have an overriding orientation setting
The following table lists some commonly-used applications with their own orientation setting
that overrides the driver's Orientation setting.    (In applications, the orientation setting can 
usually be found by selecting Page Setup, Print, or a similarly-named command from the File 
menu.)        For predictable results in all cases check to see if the application has an 
orientation setting, if so you should match its setting to the driver's Orientation setting.

Some applications with an overriding orientation setting:

CorelDRAW
Lotus Freelance Graphics
Microsoft Excel for Windows
Microsoft Word for Windows



Some applications do not work with large paper sizes.
Some applications generate internal errors when the paper size is too large.    Depending on 
the behavior of the application you may see one or more of the following symptoms:
          

              missing objects,
              mis-shaped objects,
              corrupted output,
              no output,
              General Protection Faults (GPFs). 

Some applications try to limit the reported paper size to an acceptable size.    This however 
does not ensure that the above problems will be avoided, the reported paper size may still, 
in some cases, cause problems.      

The applications exhibiting this problem are listed below with their maximum supported 
paper sizes:

     Application:       Max paper size:
      Aldus PageMaker 5.0       40" x 40" (101 x 101cm)
      Corel Ventura 4.2       A2, C
      CorelDRAW 5.0       30" x 30" (76 x 76cm)
      QuarkXPress 3.3                  26" x 26" (66 x 66cm)    



Supported Printers
This driver supports the following printers:

Printer Name Model Number
HP DesignJet Printers C1633A, C1633B
HP DesignJet 200 Printers C3180A, C3181A
HP DesignJet 220 Printers C3187A, C3188A
HP DesignJet 230 Printers C4694A, C4695A
HP DesignJet 250C Printers C3190A, C3191A
HP DesignJet 600 Printers C2847A, C2848A
HP DesignJet 650C Printers C2858A, C2859A

C2858B, C2859B
HP DesignJet 750C Printers C3195A, C3196A
HP DesignJet 755CM 
Printers

C3198A

Although there are older printer drivers with similar names to this one, please note that in 
the Windows operating environment you should use only this driver to print with the devices 
listed above (read the notes below).    Older drivers use a less-efficient graphics language 
and have limited features and settings.

Note to AutoCAD Release 12 & 13 for Windows users

The exception to the above paragraph is that we don't recommend using this Hewlett-
Packard driver when you're running AutoCAD Windows.    Instead, use the Hewlett-Packard 
driver that was shipped with AutoCAD.

To print this or any other help topic, choose Print Topic from the File menu in the Help 
window.



Used standards
The list of standard paper sizes has the following options:

ANSI 
Architectural 
DIN 
ISO 
JIS 
Oversize

Only when an option from the Used standard list is enabled will the sizes it defines be 
available in the Paper Size: drop-down list in the setup dialog box.    



Users of paint and image-processing applications
(such as Aldus PhotoStyler, Publisher's Paintbrush)

Because of the large amount of data involved, printing large-format raster images
(such as scanned images) will proceed slowly.



Using the "Process document in computer" option
If this processing mode is used with the printer connected to a local port, use of the "Print 
Manager" spooler is highly recommended.



Using the Oversize feature
In order to use the Oversize feature you must:

a) select Oversize in this Used standards dialog box 
AND
b) select the appropriate 'oversize' option from the Paper Sizes list.



Vivid Color
Vivid Color provides clear and vivid color output.    There may be a slight sacrifice in hue on 
some images. This is the default setting.



** Application notes start here



Software application notes
This topic contains general information to help you use this driver.    The information will help
you to better understand how the driver interacts with software applications.

The README.TXT file contains late breaking information relating to popular software 
applications.    If you are having problems working with a particular application, this file may 
contain information to help you find a solution.

General information

Application specific information:

Aldus Applications 
AutoCAD for Windows users
CorelDRAW/PHOTO-PAINT users
Lotus Applications 
Micrografx Designer (v4.0 & v4.1) users 
Microsoft Applications
QuarkXPress users 
Software Publishing Corporation Harvard Graphics (v2.0 & v3.0) users 



Aldus Applications
Aldus FreeHand (v3.1) users

Problems exist with gradient fills in documents imported from the Macintosh version of 
FreeHand.    If you see black lines in areas where you expect a gradient fill, we recommend 
that you replace the gradient fill area done on the Macintosh with a gradient fill done with 
Windows. 

Aldus FreeHand (v4.0) users
If you use another application while Freehand is printing, the printing may be aborted.

To avoid this problem, do not use Windows applications while Freehand is printing.

Aldus PageMaker (v5.0) users
a) We recommend that you do not use the "Double-sided", "Facing pages", or "Letterhalf" 
options under "Page Setup". This is because our driver has different right, left, top, and 
bottom margins. 

b) You should also be aware that some PageMaker line attributes are not printed properly 
when using our driver. 

c) Maximum page size    =    40 x 40 inches (1016 x 1016 mm) 

d) While printing, you will be locked out of the computer and you will not be able to use 
other 
applications.

e) Colors for some area fills are converted to solid colors.    You are recommended to 
upgrade to PageMaker version 5.0a.

Aldus Persuasion (v2.1) users
The slide dimension specified in the "Slide Setup" menu should not exceed 17 x 22 inches 
(431.8 x 558.8 mm).

Associated topics: 
Some applications do not work with large paper sizes
Color intensity using the print "Color as Grayscale" setting 
Printing lines
Printing areas with gradient shading    



Micrografx Designer (v4.0 & v4.1) users
1) Problems exist which cause objects (such as a line) to be clipped to 55 inches in length.

2) Plots with curved objects may be printed in a different perspective to that shown on 
your screen.    This version of the application has a problem with Bezier curves, Micrografx 
Designer v4.1 has fixed this problem.    
To solve this problem you can either upgrade, or use the driver's "Process document in 
computer" setting.



Software Publishing Corporation Harvard Graphics (v2.0 & 
v3.0) users

a) Problems exist that cause some pattern fills to be printed incorrectly. 
We recommend using a hatch fill if you see this problem. 

b) You cannot change the Custom Paper Size from the Print Setup dialog box of the 
application, it will not be accepted.

You are recommended to set the Custom Paper size from the Control Panel before you 
start the application.



QuarkXPress users
QuarkXPress (v3.12) users:

When used with our driver, there is a limitation on image width of approx. 26 inches.

Tiff files are printed with poor quality.    The "Using QuarkXPress" manual (page 7.21) states
the following: 

"When you print a document containing an EPS or TIFF picture to a non-PostScript 
printer, QuarkXPress prints the low-resolution image stored in the document. Non-
PostScript printers cannot print the information contained in an EPS file."

QuarkXPress (v3.3) users:
a)If you configure to print to "File:", and you do not type the destination file name in the 
"Print to file" dialog box, you will not be able to print again until you restart the application.

b)If you try to print the sample file WORLDCUP.QXD on a HP DesignJet 650C or 250C, you 
may see a "General Protection Fault".    This problem is caused by the position of the map 
of America which covers the left half of the background.    By moving this map by a small 
distance inwards direction you will find that you are able to print this drawing. 

Associated topics: 
Some applications do not work with large paper sizes
Color intensity using the print "Color as Grayscale" setting 
Printing lines
Printing areas with gradient shading 



AutoCAD for Windows
Releases 12 and 13 for Windows

IMPORTANT
AutoCAD Release 12 and 13 users should refer to the document "AutoCAD Drivers for HP

Plotters" supplied with your printer, for important information.

Paper size selection - Print Configuration dialog box

From AutoCAD's "Print Configuration" dialog box it is possible to view the available paper 
sizes by using two different methods:

i) via "Print Setup" - by clicking on the "Device and Default Selection" button to display its 
dialog box and subsequently the "Change Device Requirements" button    to display the 
"Print Setup" dialog box, then clicking on the "Size" button.

ii) via "Paper Size" - by clicking on the "Size" button to display the "Paper Sizes" dialog box.

If you select a paper size from the "Size" drop-down menu of the "Print Setup" dialog box it 
will affect the menu of paper sizes you see when you display the "Paper Sizes" dialog box.    
The list of paper sizes will be limited to all known sizes smaller than or equal to the size 
currently selected in the "Print Setup" dialog box and this size is renamed here to "MAX" and
adjusted to take into account the margins used by AutoCAD.

Recommendation:    When you have decided to use a particular paper size ensure that it is 
currently selected in the "Print Setup" dialog box and then you should always select the size 
called MAX in the "Paper sizes" dialog box.

Release 11 for Windows: use the Autodesk driver instead of this one

When using AutoCAD Release 11 for Windows, we recommend printing with the Autodesk 
driver that was automatically loaded when you installed AutoCAD.    Follow the steps below 
to ensure that you've selected the recommended driver in AutoCAD.

Step 1.From the AutoCAD main menu, choose "Configure AutoCAD" from the utilities 
menu.

Step 2.Read the text to the right of "Printer." If it says, 

"Hewlett-Packard HP-GL/2 V1.0 ADI 4.1 - By Autodesk," 

the printer configuration is correct and you don't need to do anything else; if it says
something different, continue with the next step.

Step 3.Press Enter and type 5 to select "Configure printer."

Step 4.Type Y to the question, "Do you want to select a different one?," and type 6 to 
select 

"Hewlett-Packard HP-GL/2 V1.0 ADI 4.1 - By Autodesk."

Step 5.Answer any remaining questions and return to the main menu. Be sure to save the 
configuration changes you just made.





CorelDRAW/PHOTO-PAINT users
General notes:

1) If you are trying to print a drawing that needs rotation i.e. an A1 drawing on a 24" 
plotter AND the drawing contains Corel pattern fills we recommend that you use the 
driver's    "Process document in computer" setting.    The area fills generate large output 
files which obviously take a long time to send to the printer and may generate an "Out of
memory" error which prevents printing.    Using the suggested driver setting you can 
avoid the memory problem and your drawing will be printed. 

2) If you're using CorelDRAW with this driver, you can only produce A- and B-size prints 
from a TIFF drawing.

Version specific notes:

CorelDRAW (3.0 Rev. B and later) slow printing
To speed the printing of gradient filled objects, add the following line to the [CDrawConfig] 
section of the coreldrw.ini file:

UseClippingForFills=0

For more information on locating and modifying this file, please contact Corel Corporation 
Software Support.

CorelDRAW (v3.0/v4.0) users 
Corel 3.0 maximum page size    =    20 x 20 inches (508 x 508 mm)
Corel 4.0 maximum page size    =    30 x 30 inches (762 x 762 mm) 

When canceling a drawing from CorelDRAW follow the procedure provided in the 
"Canceling    print from your application" topic in the driver's help system.    Immediately 
following a print cancel your computer may be slow to respond until CorelDRAW has 
performing a screen re-paint operation.

CorelDRAW (v5.00D1) and earlier versions
A floating point division by 0 exception can occur if you try to plot 5EFFECTS.CDR and 
other drawings with A1 landscape settings.    This problem has been fixed in later versions, 
you are recommended to updgrade (if you are unsure about your version number, click on 
"About" in "Help".)

Corel PHOTO-PAINT (v4.0) users
We recommend the free upgrade from Corel to v4.00.b3 for better performance with our 
driver. 

Associated topics: 
Some applications do not work with large paper sizes
Color intensity using the print "Color as Grayscale" setting 
Printing lines
Printing areas with gradient shading 



Microsoft Application users
Microsoft Project users

Margins
The default margins in Microsoft Project's Page Setup dialog box are too small for the 
printers this driver supports.    To remedy this problem, we recommend that you refer to the
driver margins table and enter the margins for your printer type into Microsoft Project's 
Page Setup dialog box.

Print length limit
You are recommended not to attempt to print a drawing which is 1524 mm (60 in) or 
longer, it may cause Microsoft Project v3.0 to hang.    Microsoft Project v4.0 seems to have 
solved this problem.

Microsoft Word for Windows (v2.0/v6.0) users
a) Problems exist in v2.0 that cause the bottom line of double underlines for ATM 
(PostScript Type 1) fonts to be clipped. For v6.0, the problem seems to only occur if the 
double underline text is also a subscript. 

b) When printing "To file" make sure that the characters used to specify the path and 
filename do not exceed 31 characters.    If you have used a path/filename which exceeded 
31 characters only the first 31 characters will have been used to specify a path and a 
filename.

Microsoft Works version 3.0 users
When using large size paper (i.e. A0 and E size) you may see a 'Divide By Zero' error 
message when you choose: Print Preview, or Print, AND your system is configured for one 
of the following devices: 

HP DesignJet 200    (C3181A)
HP DesignJet 220    (C3188A)
HP DesignJet 230    (C4695A)
HP DesignJet 250C    (C3191A)
HP DesignJet 600    (C2848A)
HP DesignJet 650C (C2859A)
HP DesignJet 650C (C2859B)
HP DesignJet 750C (C3196A)
HP DesignJet 755CM (C3198A)

There is a work-around solution for the above problem (Microsoft and Hewlett-Packard are 
working on a permanent solution). Please repeat the driver installation procedure and 
choose an alternative printer, see below, from the drop-down list box of the Installer dialog
box.

If you were configured for: Choose this alternative:
HP DesignJet 200    (C3181A) HP DesignJet 200    (C3180A)
HP DesignJet 220    (C3188A) HP DesignJet 220    (C3187A)
HP DesignJet 230    (C4695A) HP DesignJet 230    (C4694A)
HP DesignJet 250C    
(C3191A)

HP DesignJet 250C    (C3190A)

HP DesignJet 600    (C2848A). HP DesignJet 600    (C2847A)
HP DesignJet 650C (C2859A) HP DesignJet 650C (C2858A)
HP DesignJet 650C (C2859B) HP DesignJet 650C (C2858B)
HP DesignJet 750C (C3196A) HP DesignJet 750C (C3195A)
HP DesignJet 755CM HP DesignJet 750C (C3195A)



(C3198A)

Remember to re-configure your system to use this new device, i.e. via Print Setup..., or 
Control Panel etc.

Note that for landscape images which are D/A1 sized, or just smaller, the 'alternative' 
driver, which should also be set to landscape, will work best with paper loaded in portrait 
orientation.    This is because for large images the driver automatically re-orientates the 
image to portrait orientation in order to avoid image clipping. 

For example if your landscape image is D/A1 sized you should set the orientation setting in
the driver to landscape and load the D/A1 sized paper in portrait orientation.

For further information see Margins Portrait paper/Landscape image .

Microsoft Excel users with DesignJet Series printers
Excel 4.0 has its own Copies setting in its Page Setup dialog box and may cause problems
with this driver.    We recommend that you use Excel as a means of requesting multiple 
copies of a print and set the Copies field in the Setup dialog box in the driver to 1.

Microsoft Excel (v4.0 and v5.0) users
We recommend using the driver control panel for page setup rather than using the Page 
Setup menu within the application. 

Problems also exist that prevent printing of some border patterns that appear on the 
screen.    Excel V5.0 seems to have fixed these problems. 

Some light fill patterns in Excel 5.0 may not come out as shown on the screen.    If you are 
having this problem, we recommend using Manual Color and selecting No Adjustment.

Associated topics: 
Some applications do not work with large paper sizes
Color intensity using the print "Color as Grayscale" setting 
Printing lines
Printing areas with gradient shading 



Lotus Applications
Lotus 1-2-3 (4.0) users

a) The "Preview" feature of Lotus 1-2-3 with the following page formats and sizes:

594 x 841 mm (ISO A1)or larger, or
22 x 34 in (ANSI D) or larger

b) You cannot print nor preview Lotus 1-2-3 files with the following page formats and 
sizes:

841 x 1188 mm (ISO A0)or larger, or
34 x 44 in (ANSI E) or larger

c) There is a difference between Lotus 1-2-3 and your printer driver in the way they 
handle certain colors.    When these colors are used for solid area fills they are reported 
to the printer driver as a mix of colors to be mixed by the printer using a process 
known as 'dithering.'    When these colors are printed they are not solid and appear to 
have a very fine pattern.

d) Problems exist that cause the orientation of some patterns to be printed differently 
than shown on the screen. Also, page sizes larger than ANSI-C may not print. 

Lotus Ami Pro (v3.0 & v3.1) users
a) To improve printing of hatch patterns, add the following line to the [AmiPro] section in 

the C:\WINDOWS\AMIPRO.INI file.

DefOptions1=2

b) If your document uses vector fonts (i.e. Modern, Roman, Script) you may see a 
difference in the printed fonts if you change between the Print document... "In printer" 
and "In computer" settings.    

To avoid these differences of font use only TrueType fonts.

c) Windows 95 only - If your documents are printed using the wrong pattern fills, check 
the "Print in background" setting.    If it is selected, this could be the cause of the 
problem.    We recommend that you de-select this setting.    To access the setting go to 
the Tools menu and select User setup then Options.    The "Print in background" 
setting is in the "User Setup Options" dialog box. 

Lotus FreeLance Graphics (v2.0 & v2.1) users
To prevent unexpected results when printing in color, make sure the "Adjust color library 
for color printing" switch is disabled when doing a 'Print'.

Problems exist that prevent the background from being printed on a DesignJet 600. 

Associated topics: 
Some applications do not work with large paper sizes
Color intensity using the print "Color as Grayscale" setting 
Printing lines
Printing areas with gradient shading 



General Troubleshooting
More troubleshooting hints which are specific to printer types are available at the end of this 
list.

Click on the symptom to view the possible solution.

If the printer you want to use isn't displayed in the Control Panel (Printers dialog box)

If the top and/or bottom of your print is missing (clipped)

If the driver's Orientation setting seems to have no effect on prints

If printing text produces unexpected results

If your printer is unusually slow or appears to be "hung".

If your computer displays a time-out message before all print data has been received by the 
printer

If the printed drawing size is smaller than the driver's Paper Size setting

If you have disk space problems or misplaced objects when you print a drawing (Windows 95
only)

Further information

Font support and recommendations
HP DesignJet series printers

Alternatively, refer to the following documents for help.

The user's guide for your printer, and

The user's guide for your software application.

To print this or any other help topic, choose Print Topic from the File menu in the Help 
window.



Troubleshooting HP DesignJet series printers
* If the color of printed ATM text is not what you expect

The color of ATM text sent as graphics is enhanced according to the Graphics setting 
in the driver and not as Text.    This driver no longer requires the ATM Control Panel to 
be set as "Print ATM fonts as graphics", instead you are recommended to select "Use 
pre-built or resident fonts".    This setting will avoid any differences in text color and will
improve performance.

* If prints won't rotate using the printer's front panel Rotate feature (HP 
DesignJet and HP DesignJet 600 printer users only).

Your print may have rasterized data in it.    Due to rotate buffer memory limitations, 
rasterized drawings (e.g., drawings with heavy area fill and shading that you've 
scanned into your application) can't be rotated from the printer's front panel.    Try 
using your application's rotate feature.

* If filled and overlapping objects are printed incorrectly.

The HP DesignJet 200, 220, 230, 250C, 600, 650C printers are capable of printing both 
rasterized data and    overlapping objects correctly.    The HP DesignJet printers are 
raster-capable, but they can't print overlapping objects correctly and they have more 
raster limitations than the later DesignJet models.

* If printed gray shades look different than expected.

Make sure that your application software, and not your printer, is set to be the source 
of pen parameters.    For instructions refer to one of the following:

HP DesignJet printer notes
HP DesignJet 200, 220, 230 and 250C printer notes
HP DesignJet 600, 650C, 750C and 755CM printer notes

* If the printer's expanded margin feature doesn't work.

This driver doesn't support the Expanded margin feature.



**Pop-up box texts start here



Examples of halftoning

Scatter Pattern Cluster



Try this:
Run the driver's install program again and select the new Printer type.
For instructions refer to "Installing with the driver's quick "install" program (recommended 
method)," in the guide that came with this driver.



Try this:
1) Make sure the driver's Paper Size setting is exactly the same as the Page Size you've 

specified in your application.

OR

2) Do one of the following: 

a) Adjust the margin settings in your application to match the driver's margin settings 
for the selected printer type, see Printer margin settings using this driver, or 

b) scale down the size of the drawing in your application, or 
c) increase the Paper Size setting in the driver and ensure that your loaded paper is 

large enough for the new Paper Size setting



Try this:
Your application may have an orientation setting that overrides the Orientation setting in this
driver's Set up dialog box.    We know that the following applications work in this way, and 
there may be others as well: 

Lotus Freelance Graphics,
Microsoft Excel for Windows, and
Microsoft Word for Windows.

For predictable results in all cases you should match the driver's Orientation setting to the 
application's orientation setting.



Try this:
If:

*    text is not printed, or
*    objects are misplaced

Refer to Font support and recommendations, to learn about this driver's font support for 
each printer type.



Try this:
1) Make sure you're using the recommended font type.    Refer to "Font support and 

recommendations," for more information.    Multi-page documents print very slowly and 
the printer may appear to be "hung." If this happens, try using one of the TrueType fonts 
or one of the standard Windows vector fonts instead.

AND

2) Check the Orientation and Paper Size settings in the driver.    If you're printing in 
landscape mode on the largest paper size of your printer, printing may be very slow.    If 
you want to print faster, change the driver's Orientation setting to portrait, and rotate 
the drawing 90 degrees in your application.



Try this:
Try increasing the Transmission Retry value to 900 seconds.    To access this setting choose 
Control Panel, Printers, then Connect.



Try this:
1) Make sure that the driver's Paper Size setting is exactly the same as the Page Size you've 

specified in your application.

AND

2) Your application may have a maximum print size limit.    If so, your drawing will be 
truncated at the limiting dimensions.    For example, some applications limit drawings to 
18.0 x 18.0 inches 457 x 457 mm); if you specify a larger Paper Size in the driver - "ANSI E
34 x 44 in," for example - your 18.0 x 18.0-inch drawing will be printed in one corner of 
the E-size paper.



Try this:
For Windows 95 users, the default spooling format is EMF (Enhanced Metafile).    By using 
this format, the application is freed from printing sooner.    However, under some 
circumstances the EMF format can cause problems such as disk space or misplaced 
objects.    If you encounter such problems, choose the RAW spool format and try to print 
again.    To change the spool format go to Printer properties, choose the Details tab and 
click the Spool Settings button.



length
Enter the largest dimension of your paper in this field, regardless of its axis relative to the 
printer.



This driver supports the following printers:

Printer Name Model Number
HP DesignJet Printers C1633A, C1633B
HP DesignJet 200 Printers C3180A, C3181A
HP DesignJet 220 Printers C3187A, C3188A
HP DesignJet 230 Printers C4694A, C4695A
HP DesignJet 250C Printers C3190A, C3191A
HP DesignJet 600 Printers C2847A, C2848A
HP DesignJet 650C Printers C2858A, C2859A, C2858B, C2859B
HP DesignJet 750C Printers C3195A, C3196A
HP DesignJet 755CM Printer C3198A



Units
Using this button you can switch between 'inch' and 'mm' to select the units of 
measurement.



What is ANSI?
ANSI is an abbreviation for American National Standards Institute.



What is Architectural?
"Architectural" represents a series of media sizes which have been created to suit the needs 
of the construction industry, stated in inches.



What is DIN?
DIN is an abbreviation for Deutsche Industrie Norm.



What is ISO?
ISO is an abbreviation for International Standardization Organization.



What is JIS?
JIS is an abbreviation for Japanese Industrial Standard.



width
Enter the smallest dimension of your paper in this field.




